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ET-2400 User's Guide
Welcome to the ET-2400 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics
See these sections to learn about the basic features of your product.
Control Panel Buttons and Lights
Product Parts Locations
The Power Off and Sleep Timers
Using the Epson Smart Panel Mobile App
Voice-activated Printing
Epson Connect Solutions for Smartphones, Tablets, and More
Setting Up Printing on a Chromebook
Android Printing Using the Epson Print Enabler
Using Epson Print and Scan App with Windows Tablets

Control Panel Buttons and Lights

1 power button and light
2 Wi-Fi and Wi-Fi Direct network status lights
3 Wi-Fi button
4 network status button
5 B&W copy button
6 color copy button
7 stop button
8 ink and paper lights
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Light status Condition/solution
power light is on The product is turned on.

Wi-Fi light is on The product is connected to a wireless network.

Wi-Fi Direct light is on The product is connected to a device using Wi-Fi Direct.

Parent topic: Product Basics

Product Parts Locations
See these sections to identify the parts on your product.
Product Parts - Front
Product Parts - Inside
Product Parts - Back
Parent topic: Product Basics

Product Parts - Front

1 Rear paper feeder
2 Paper support
3 Edge guides
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4 Feeder guard
5 Output tray
6 Paper stopper

Parent topic: Product Parts Locations

Product Parts - Inside

1 Document cover
2 Scanner glass
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3 Control panel

1 Scanner unit
2 Ink tank cap
3 Ink tank cover
4 Ink tank unit
5 Ink tanks
6 Front cover
7 Scanner unit support
8 Print head

Parent topic: Product Parts Locations
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Product Parts - Back

1 AC inlet
2 USB port

Parent topic: Product Parts Locations

The Power Off and Sleep Timers
The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management begins, but increasing the time reduces the product's
energy efficiency.
Changing the Power Off and Sleep Timer Settings - Windows
Changing the Power Off and Sleep Timer Settings - Mac
Parent topic: Product Basics

Changing the Power Off and Sleep Timer Settings - Windows
You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Printer Settings and click the
Maintenance tab.
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2. Click the Printer and Option Information button.
You see this window:

3. Select the time period you want as the Power Off Timer setting.

Note: Your product may have the Power Off Timer feature or Power Off If Inactive and Power Off
If Disconnected features depending on the location of purchase.

4. Click Send.
5. Select the time period you want as the Sleep Timer setting.
6. Click Send.
7. Click OK to close the open program windows.
Parent topic: The Power Off and Sleep Timers

Changing the Power Off and Sleep Timer Settings - Mac
You can use the printer software to change the time period before the printer enters sleep mode or turns
off automatically.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select Printer Settings.
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You see this screen:

3. Select the time period you want as the Power Off Timer setting.

Note: Your product may have the Power Off Timer feature or Power Off If Inactive and Power Off
If Disconnected features depending on the location of purchase.

4. Select the time period you want as the Sleep Timer setting.
5. Click Apply.
6. If you see the confirmation message, click Yes, and close the Printer Settings window.
Parent topic: The Power Off and Sleep Timers

Using the Epson Smart Panel Mobile App
Use this free Apple and Android app to set up and control your Epson product. Epson Smart Panel also
lets you check product status.

Note: App features may vary depending on your Epson product.

1. Visit epson.com/connect (U.S.) or epson.ca/connect (Canada) to learn more about Epson Smart
Panel and check the compatibility of your mobile device.

https://www.epson.com/connect
https://www.epson.ca/connect
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2. Download Epson Smart Panel from the Apple App Store or Google Play.
3. Do one of the following:

• If your Epson product is already connected to a wireless network, connect your mobile device to
the same network. Then open Epson Smart Panel and select your Epson product, if necessary.

• If your Epson product is not connected to a wireless network, connect your mobile device to the
network you want to use, then open Epson Smart Panel and follow the instructions to set up your
Epson product.

Now you are ready to control your Epson product with your mobile device.
Parent topic: Product Basics
Related topics
Wi-Fi Networking

Voice-activated Printing
Take advantage of voice-activated, hands-free printing from your Epson product with Alexa, Siri, and
Google Assistant. Depending on which voice assistant you use, you can ask your product to print
photos, calendars, recipes, photo props, and more. Click here for more information.
1. Connect your product to your network. See the link below.
2. Set up your product's email address for use with Epson Connect. See the link below to activate it

from the product control panel.
3. Click here for instructions on how to set up your product and voice assistant to use the voice-

activated printing feature.
Now you are ready to print with your voice and your Epson product.
Parent topic: Product Basics

Epson Connect Solutions for Smartphones, Tablets, and More
Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages
from your home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

https://epson.com/voice
https://epson.com/voice
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Print from anywhere with these Epson Connect solutions:
• Epson Email Print
• Epson Remote Print
Using Epson Email Print
Using Epson Remote Print
Parent topic: Product Basics

Using Epson Email Print
With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.
1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, visit

epson.com/connect (U.S.) or epson.ca/connect (Canada) to learn more about Email Print, create
your Epson Connect account, and register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi Networking

Using Epson Remote Print
With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.
1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software,

visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

https://www.epson.com/connect
https://www.epson.ca/connect
http://www.epsonconnect.com
http://www.epsonconnect.com
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3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer

application and choose the Remote Print option for your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
Related topics
Wi-Fi Networking

Setting Up Printing on a Chromebook
Your Epson printer supports native printing on Chromebook, allowing you to print from a Chromebook
without drivers or cables.
For directions on setting up your printer, visit Setting Up Your Epson Printer on Your Chromebook (U.S.)
or Setting Up Your Epson Printer on Your Chromebook (Canada).
Parent topic: Product Basics

Android Printing Using the Epson Print Enabler
You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.
1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in, if necessary.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu

icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.

Parent topic: Product Basics

http://www.epsonconnect.com
https://epson.com/Support/wa00901
https://epson.ca/support/wa00901
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Related topics
Wi-Fi Networking

Using Epson Print and Scan App with Windows Tablets
You can use this free app to print photos and scan from your Windows (Windows 8 or higher) Surface
RT or Pro tablet with networked Epson products. The Epson Print and Scan app allows you to scan and
capture images right to your tablet or to Microsoft OneDrive.

Note: The Epson Print and Scan app does not support Windows 10 Mobile printing and does not supply
scanning functions for products without scanners.

1. Connect your Epson product to your wireless network. See the link below.
2. Download the Epson Print and Scan app from the Microsoft Windows Store.
3. Connect your Windows tablet to the same wireless network as your product.
4. Open the Epson Print and Scan app and select your Epson product.

Now you are ready to print photos or scan.
Parent topic: Product Basics
Related topics
Wi-Fi Networking
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Wi-Fi Networking
See these sections to use your product on a Wi-Fi network.
Network Security Recommendations
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations
To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.
Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:
• Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

• Connect your product only to a network protected by a firewall
Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Wi-Fi Direct Mode Setup
You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to 8 devices.

1 Epson product
2 Computer with a wireless interface
3 Other wireless device

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi Networking

Enabling Wi-Fi Direct Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point. Make sure paper is loaded before you begin.

Note: If you are printing from a computer, make sure you installed the network software as described on
the Start Here sheet.
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1. Hold down the Wi-Fi button and press the network status button until the Wi-Fi light and
Wi-Fi Direct light flash alternately. Then release both buttons.

Note: When you are using an Android device and connect to the printer using Wi-Fi Direct, the
Wi-Fi light and Wi-Fi Direct light flash simultaneously on the printer.

After both lights stop flashing, the Wi-Fi Direct light remains on.

2. Hold down the network status button for about seven seconds to print a network status sheet.
3. Use your computer or wireless device to select the Wi-Fi network name (SSID) and password listed

in the Wi-Fi Direct section of the network status sheet.
You should now be able to print to your product directly from your computer or device. If you cannot
print successfully, repeat the process above and make sure you enter the password exactly as
written on the network status sheet.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network
If you have a WPS-enabled router or access point, you can use Wi-Fi Protected Setup (WPS) to connect
your device to the network.

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

1. Press the WPS button on your router or access point.
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2. Hold down the Wi-Fi button on your product for about five seconds until the Wi-Fi light and Wi-
Fi Direct light flash alternately.
The Wi-Fi light turns green to indicate a successful connection.

Note: Be sure to press and hold the Wi-Fi button on your product within 2 minutes of pressing the
WPS button on your router or access point.

Parent topic: Wi-Fi Protected Setup (WPS)
Related references
Product Light Status

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

To print the status sheet, hold down the network status button on the product for at least seven
seconds.

Note: If you release the button before seven seconds elapses, a network connection report is printed
instead of a network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you may have.
Parent topic: Wi-Fi Networking

Printing a Network Connection Report
You can print a network connection report that provides details of the connection between the product
and the wireless router.

1. To print the network connection report, press the network status button on the product.
2. Review the information contained in the report and resolve any errors.
Network Connection Report Codes and Messages
Parent topic: Wi-Fi Networking
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Network Connection Report Codes and Messages
Check the error codes and messages on the network connection report to solve problems you may
encounter with network connections. The tables here list solutions to problems based on the error codes
and messages that may appear on the top of the report.

1 Error code
2 Message

Note: Error codes and messages listed here may not all apply to your product.

Error Codes and Messages

Error code and message Solution
E-1
Confirm that the network cable is
connected and network devices such as
hub, router, or access point are turned on.

Make sure your router, access point, and/or hub are
turned on, and the network cable is securely connected to
your device and to your product.
If you are trying to set up Wi-Fi, remove the network cable
and set up Wi-Fi again. Ethernet and Wi-Fi cannot be
connected at the same time.
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Error code and message Solution
E-2, E-3, or E-7
No wireless network names (SSID) found.
Confirm that the router/access point is
turned on and the wireless network (SSID)
is set up correctly. Contact your network
administrator for assistance.
No wireless network names (SSID) found.
Confirm that the wireless network name
(SSID) of the PC you wish to connect is set
up correctly. Contact your network
administrator for assistance.
Entered security key/password does not
match the one set for your router/access
point. Confirm security key/password.
Contact your network administrator for
assistance.

Check the following:
• Make sure your router or access point is turned on, and

is correctly connected to your computer or network
device.

• Turn off the router or access point, wait about 10
seconds, and turn it on again.

• Move your product closer to your router or access point,
and remove any obstacles between them. Also move
your product away from devices such as wireless
phones or microwaves.

• Confirm that the SSID shown on the network
connection report matches the label on your router or
access point. Also make sure your SSID uses only
ASCII characters and symbols, or your product cannot
display the SSID correctly.

• If you are trying to connect using the WPS push button
method, make sure your router or access point supports
it.

• If you are using a network password, check the label on
your router or access point to confirm that you are using
the correct password, or check with your network
administrator or router/access point documentation.

• If you are connecting to a smart device that generates
an SSID, check the device documentation for the SSID
and password you should use.

• If your wireless connection suddenly disconnects, and
another smart device was added to the network using a
WPS push button method or your network was set up
using a non-WPS push button method, try downloading
and installing your product software again.
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Error code and message Solution
E-5
Security mode (e.g. WEP, WPA) does not
match the current setting of the printer.
Confirm security mode. Contact your
network administrator for assistance.

If the security on your router or access point is not one of
the following types, change the type of security on your
router or access point and reset your product's network
settings.
• WEP-64 bit (40 bit)
• WEP-128 bit (104 bit)
• WPA PSK (TKIP/AES); also known as WPA Personal
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal
• WPA (TKIP/AES)
• WPA2 (TKIP/AES)
• WPA3-SAE (AES)

E-6
MAC address of your printer may be
filtered. Check whether your router/access
point has restrictions such as MAC address
filtering. See the documentation of the
router/access point or contact your network
administrator for assistance.

If your router or access point has MAC address filtering
enabled, register your product's MAC address so it is not
filtered. Locate the MAC address on the network
connection report and check your router or access point
documentation for instructions.
If your router or access point is using shared
authentication with WEP security, confirm that you are
using the correct authentication key and index.
If your router or access point limits the number of
connected devices, raise the connection limit. See your
router or access point documentation for instructions.

E-8
Incorrect IP address is assigned to the
printer. Confirm IP address setup of the
network device (hub, router, or access
point). Contact your network administrator
for assistance.

If your product's Obtain IP Address setting is set to Auto,
enable DHCP on your router or access point. If it is set to
Manual, the IP address may be out of range or on a
different network segment; set a valid IP address using
your product control panel or the Web Config utility.
You can also try turning off your product and the router or
access point, waiting about 10 seconds, and turning them
on again.
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Error code and message Solution
E-9
Confirm the connection and network setup
of the PC or other device. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure your computer or network device are turned
on. Also make sure that you can access the Internet and
other devices on the same network from the devices you
are trying to connect to your product.
If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again. Download and install your product software
again to reset your network settings.

E-10
Confirm IP address, subnet mask, and
default gateway setup. Connection using
the EpsonNet Setup is available. Contact
your network administrator for assistance.

Make sure other devices on the network are turned on and
do the following:
• If your product's Obtain IP Address setting is set to

Manual, check the IP address, subnet mask, and
default gateway addresses on the network connection
report to see if they are correct. If not, correct the
settings.

• If DHCP is enabled, set your product's Obtain IP
Address setting to Auto. If you want to use the DHCP-
assigned address as a static address, set the Obtain IP
Address setting to Manual, enter the product's IP
address as listed on the network connection report, and
set the subnet mask to 255.255.255.0.

If you still cannot connect to your product, turn off your
router or access point, wait about 10 seconds, and turn it
on again.

E-11
Setup is incomplete. Confirm default
gateway setup. Connection using the
EpsonNet Setup is available. Contact your
network administrator for assistance.

If you set your product's TCP/IP Setup setting to Manual,
check that the default gateway address listed on the
network connection report is correct. Also turn on the
device that is set as the default gateway.
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Error code and message Solution
E-12
Confirm the following:
-Entered security key/password is correct
-Index of the security key/password is set to
the first number
-IP address, subnet mask, or default
gateway setup is correct
Contact your network administrator for
assistance.

Make sure other devices on the network are turned on and
do the following:
• Make sure the IP address, subnet mask, and default

gateway addresses are correct, if you are entering them
manually.

• Confirm that the subnet mask and default gateway
addresses for other devices are the same.

• Make sure the IP address does not conflict with other
devices.

If you still cannot connect to your product, do the
following:
• Turn off your router or access point, wait about 10

seconds, and turn it on again.
• Download and install your product software again to

reset your network settings.
• If your router or access point uses WEP security with

several registered passwords, make sure that the first
registered password is set on your product.

E-13
Confirm the following:
-Entered security key/password is correct
-Index of the security key/password is set to
the first number
-Connection and network setup of the PC
or other device is correct
Contact your network administrator for
assistance.

Make sure your router, access point, and/or hub are
turned on. Also make sure the TCP/IP setup on your
router, access point, and/or hub is not set manually; this
may cause your product's network settings to differ from
the manually set up devices.
If you still cannot connect to your product, do the
following:
• Turn off your router or access point, wait about 10

seconds, and turn it on again.
• Download and install your product software again to

reset your network settings.
• If your router or access point uses WEP security with

several registered passwords, make sure that the first
registered password is set on your product.
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Network Environment Messages

Message Solution
The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

Move your product closer to your router or access point,
and remove any obstacles between them. Then turn off
your router or access point, wait about 10 seconds, and
turn it back on again. If you still cannot connect to your
product, check the documentation that came with your
router or access point for solutions.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

You can connect up to 8 computers or other devices to
your product using a Wi-Fi Direct (Simple AP) connection.
If you want to add another device, disconnect an existing
connected device first.

Parent topic: Printing a Network Connection Report

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.
Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features
Parent topic: Wi-Fi Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.
1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web

browser.
4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
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Parent topic: Changing or Updating Network Connections
Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the

Start Here sheet.
Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software

Connecting to a New Wi-Fi Router
If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation for instructions.

1. Do one of the following:
• Windows: Uninstall your product software.
• Mac: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software
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Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection. You can disable the Wi-Fi features by resetting
the network settings to their default values.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use. These
settings will be reset to their default values.

1. Turn off the product.

2. Hold down the network status button and press the power button until the Wi-Fi light and
Wi-Fi Direct light flash alternately. Then release both buttons.

When the Wi-Fi light and Wi-Fi Direct light turn off, Wi-Fi is disabled.
Parent topic: Changing or Updating Network Connections
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper in the Sheet Feeder
Paper Loading Capacity
Double-sided Printing Capacity
Compatible Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings

Loading Paper in the Sheet Feeder
You can print documents and photos on a variety of paper types and sizes.
1. Flip the feeder guard forward, then raise the paper support.

2. Slide the edge guides out all the way.
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3. Pull out the output tray and open the paper stopper.

4. If you are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even
the edges.

Note: Do not fan or curl photo paper.

5. Do one of the following:
• Insert paper, glossy or printable side up and short edge first, in the center of the paper support.
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• Load up to 10 envelopes in the center of the paper support. Load them printable side up and flap
edge left.

• Load a sheet of loose-leaf or other paper with holes facing as shown.

• To load a sheet of paper longer than legal size, close the paper support and flatten the leading
edge of the paper as shown.
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6. Slide the edge guides against the paper, but not too tightly. Then flip the feeder guard back.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guide.
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• Do not load envelopes that are curled, folded, or too thin, or that have plastic windows or exposed

adhesive flaps.
• Check the paper package for any additional loading instructions.
• Do not place objects on the feeder guard. Doing so may prevent paper from feeding.
• Do not leave paper in the printer as the paper may curl or the print quality may decline.
• If you use paper with binder holes, load only one sheet at a time in only these sizes: Letter (8.5 × 11

inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), or Legal (8.5 × 14 inches
[216 × 356 mm]).

Parent topic: Loading Paper
Related references
Paper Loading Capacity
Paper Specifications
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Paper Loading Capacity
Paper type Loading capacity
Plain paper
Copy paper
Epson Bright White Premium Paper
Epson Bright White Pro Paper
Epson EcoTank Premium Paper
Epson Multipurpose Plus Paper

Letter (8.5 × 11 inches [216 × 279 mm]), A4
(8.3 × 11.7 inches [210 × 297 mm]), Executive
(7.25 × 10.5 inches [184 × 267 mm]), Half Letter
(5.5 × 8.5 inches [140 × 216 mm]), or A6 (4.1 × 5.8
inches [105 × 148 mm]) size: 100 sheets
Legal (8.5 × 14 inches [216 × 356 mm]), 8.5 × 13
inches (216 × 330 mm), Mexico-Oficio (8.5 × 13.4
inches [216 × 340 mm]), or Oficio 9 (8.46 × 12.4
inches [215 × 315 mm]) size: 1 sheet

Epson Presentation Paper Matte
Epson High Quality Ink Jet Paper

80 sheets

Epson Premium Presentation Paper Matte
Epson Photo Paper Glossy
Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss
Epson Value Photo Paper Glossy

20 sheets
If paper feeds incorrectly, or printing is uneven or
smeared, load 1 sheet at a time.

Epson Premium Presentation Paper Matte
Double-sided

1 sheet

Envelopes 10 envelopes

Parent topic: Loading Paper

Double-sided Printing Capacity
You can print double-sided on the paper types and sizes listed here.
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Paper type Size Double-sided printing
capacity

Plain paper
Copy paper

Letter (8.5 × 11 inches [216 × 279 mm]),
A4 (8.3 × 11.7 inches [210 × 297 mm]),
Executive (7.25 × 10.5 inches
[184 × 267 mm]), Half Letter (5.5 × 8.5
inches [140 × 216 mm]), or A6 (4.1 × 5.8
inches [105 × 148 mm])

30 sheets

Legal (8.5 × 14 inches [216 × 356 mm]),
Mexico-Oficio (8.5 × 13.4 inches
[216 × 340 mm]), 8.5 × 13 inches
(216 × 330 mm), Oficio 9 (8.46 × 12.4
inches [215 × 315 mm]), or User-defined
sizes

1 sheet

Epson Premium Presentation Paper
Matte Double-sided

Letter (8.5 × 11 inches [216 × 279 mm]) 1 sheet

You cannot print double-sided on the following paper types:
• Epson High Quality Ink Jet Paper
• Epson Presentation Paper Matte
• Epson Photo Paper Glossy
• Epson Value Photo Paper Glossy
• Epson Premium Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss
• Epson Ultra Premium Photo Paper Glossy
• Epson Premium Presentation Paper Matte
• Envelopes
Parent topic: Loading Paper

Compatible Epson Papers
You can purchase genuine Epson ink and paper at epson.com (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

https://www.epson.com
https://www.epson.ca
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Paper Type Size Part number Sheet count

Epson Bright White Premium
Paper

Letter (8.5 × 11 inches
[216 × 279 mm])

S450218-4 500

Epson Bright White Pro Paper Letter (8.5 × 11 inches
[216 × 279 mm])

S041586 500

Epson Multipurpose Plus Paper Letter (8.5 × 11 inches
[216 × 279 mm])

S450217-4 500

Epson EcoTank Premium Paper Letter (8.5 × 11 inches
[216 × 279 mm])

S041586-ET 500

Epson High Quality Ink Jet Paper A4 (8.3 × 11.7 inches
[210 × 297 mm])

S041117 100

Letter (8.5 × 11 inches
[216 × 279 mm])

S041111 100

Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809
S042038

50
100

A4 (8.3 × 11.7 inches
[210 × 297 mm])

S041140 20

Letter (8.5 × 11 inches
[216 × 279 mm])

S041141 20

Epson Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S041727 100
5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches
[216 × 279 mm]) S041667 50

Epson Ultra Premium Photo Paper
Glossy

4 × 6 inches (102 × 152 mm) S042181
S042174

60
100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches
[216 × 279 mm])

S042182
S042175

25
50
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Paper Type Size Part number Sheet count
Epson Premium Photo Paper
Semi-gloss

4 × 6 inches (102 × 152 mm) S041982 40
Letter (8.5 × 11 inches
[216 × 279 mm])

S041331 20

Epson Presentation Paper Matte Letter (8.5 × 11 inches
[216 × 279 mm])

S041062 100

Epson Premium Presentation
Paper Matte

8 × 10 inches (203 × 254 mm) S041467 50
Letter (8.5 × 11 inches
[216 × 279 mm])

S041257 50

Epson Premium Presentation
Paper Matte Double-sided

Letter (8.5 × 11 inches
[216 × 279 mm])

S041568 50

Epson Value Photo Paper Glossy Letter (8.5 × 11 inches
[216 × 279 mm])

S400031 50

4 × 6 inches (102 × 152 mm) S400032
S400033
S400034

20
50
100

Parent topic: Loading Paper

Borderless Paper Type Compatibility
You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
• Epson Premium Photo Paper Glossy
• Epson Ultra Premium Photo Paper Glossy
• Epson Photo Paper Glossy
• Epson Premium Photo Paper Semi-gloss
• Epson Value Photo Paper Glossy

Borderless Paper Sizes
4 × 6 inches (102 × 152 mm)
Parent topic: Loading Paper
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Paper or Media Type Settings
For this paper Select this paper Type or Media Type setting
Plain paper
Copy paper
Epson Presentation Paper Matte
Epson Bright White Premium Paper
Epson Bright White Pro Paper
Epson Multipurpose Plus Paper
Epson EcoTank Premium Paper

Plain Paper / Bright White Paper

Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy
Epson Value Photo Paper Glossy

Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-
sided

Premium Presentation Paper Matte

Envelopes Envelope

Parent topic: Loading Paper
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Placing Originals on the Product
Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass
You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or
A4 (8.3 × 11.7 inches [210 × 297 mm]).
1. Open the document cover.

Note: If there is any dust or dirt on the scanner glass, the scanning range may expand to include it,
so the image of the original may be displaced or reduced. Remove any dust and dirt on the scanner
glass before scanning.
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2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least
0.2 inch (4.5 mm) away from the edge of the scanner glass and at least 0.8 inch (20 mm) away from
each other.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the
scanner glass. Manually position your original away from the edges to prevent cropping.

Note: When placing bulky originals such as books, prevent exterior light from shining directly onto
the scanner glass.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the
product.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they
may stick to the glass surface.
Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
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Copying
See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos

Copying Documents or Photos
You can copy color or black-and-white documents or photos onto plain paper.
1. Place your original document or photo on the scanner glass.
2. Load plain paper in one of these sizes: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7

inches [210 × 297 mm]).
3. Do one of the following to start copying:

• To copy a black-and-white original, press the B&W copy button.

• To copy a color original, press the color copy button.

• To copy a black-and-white or color original in draft mode, press the B&W copy button or the
color copy button and the stop button at the same time.

• To make more than one copy, repeatedly press the B&W copy button or the color copy
button for the number of copies you need (up to 20 copies). For example, to make 4 copies, press
the button four times. Make sure you press the button in intervals of less than one second.

Note: Margins with a width of 3 mm appear around the edges of the paper.

The product scans and prints your copy.

Note: To cancel copying, press the stop button.

Parent topic: Copying
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Printing from a Computer
Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Printing from a Smartphone or Tablet
Printing with Epson Photo+
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Checking Print Status - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
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Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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4. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.

5. If you are printing a borderless photo, select Borderless. You can click Settings to access
additional options for borderless printing.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

6. Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.
9. Select a Color option:

• To print a color document or photo, select the Color setting.
• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

10. To print on both sides of the paper, select a 2-Sided Printing option.
11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

one of the settings in the Multi-Page menu and select the printing options you want.
12. To print multiple copies and arrange their print order, select the Copies options.
13. To reduce noise during printing when you select Plain Paper/Bright White Paper, turn on Quiet

Mode (printing will be slower).
14. To preview your job before printing, select Print Preview.
15. To save your print job as a project that can be modified and combined with other print jobs, select

Job Arranger Lite.
Print Quality Options - Windows
Multi-Page Printing Options - Windows
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Parent topic: Printing with Windows
Related references
Paper or Media Type Settings
Borderless Paper Type Compatibility
Related tasks
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows

Print Quality Options - Windows
You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft

For draft printing on plain paper.
Draft - Vivid

For draft printing on plain paper with good quality and print speed.
Standard

For everyday text and image printing.
Standard - Vivid

For text and graphics with good quality and print speed.
High

For photos and graphics with high print quality.
More Settings

Opens a window that lets you choose among levels of speed and quality.
Parent topic: Selecting Basic Print Settings - Windows

Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up, 4-Up, 6-Up, 8-Up, 9-Up, and 16-Up

Prints several pages on one sheet of paper. Click the Layout Order button to select page layout and
border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows
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Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: You will need to print one side and flip the paper over manually to print the other side.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
• Manual (Long-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the long edge to print the other side.
• Manual (Short-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the short edge to print the other side.
2. Click the Settings button.
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You see a window like this:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.
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Note: The surface of the paper may smear during double-sided printing. Make sure the ink has dried
before reloading the paper.

Double-sided Printing Options - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows
You can select any of the available options on the Binding Settings window to set up your double-sided
print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
Binding Margin Options

Select options that define a wider margin to allow for binding.
Booklet

Select the Booklet checkbox to print double-sided pages as a booklet.
Create Folded Booklet Options

Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.
Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:
• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your

document or photo as the Document Size setting, and the size of your paper as the Output Paper
setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Color Correction options:
• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.
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• Select Custom and click the Advanced button to manually adjust the color correction settings or
turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:

• Anti-Copy Pattern: adds a watermark that only appears when your printout is copied

Note: This setting is not available for all types of printing. Click the Add/Delete button to create
your own pattern, and click the Settings button to customize the pattern.

• Watermark: adds a visible watermark to your printout

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
Custom Color Correction Options - Windows
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
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Custom Color Correction Options - Windows
You can select any of the available options in the Color Correction window to customize the image colors
for your print job.

Color Controls
Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.
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ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Additional Layout and Print Options - Windows
Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options
Emphasize Text

Adjusts the weight of printed text to increase readability.
Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.
Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Fix Red-Eye

Reduces or removes red-eye in photos.
Print Text in Black

Prints colored text in black.
For Color Text

Prints colored text on a background pattern or underlined.
For Color Graphs and Images

Prints colored graphics and images with overlay patterns.
For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.
Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options
Rotate 180º

Prints the image rotated 180º from its original orientation.
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Bidirectional Printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print
quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.
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You can select to print the following information:
• User Name
• Computer Name
• Date
• Date/Time
• Document Name
• Collate Number
• Page Number
• Text

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

2. Place your cursor over one of the Printing Presets to view its list of settings.
3. Click on a preset to change its settings or delete it, or use any of the available options on the screen

to control your printing presets.
4. To choose a preset for printing, select it.
5. Click OK.
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Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.

You see the maintenance options:

4. Click the Extended Settings button.
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You see this window:

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.
Extended Settings - Windows
Parent topic: Printing with Windows

Extended Settings - Windows
You can select these settings on the Extended Settings window.
Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.
Thick Paper and Envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Short Grain Paper

Prevents ink from smearing when you print on envelopes or other thick paper, and the Thick Paper
setting does not help.

Separator Page
Before each document, prints a separator page containing the title, user, date, and time.
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Remove white borders
Removes white margins that may appear when you print borderless photos.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Barcode mode
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Use a Mixture of Color Inks to Create Black
Mixes color inks to create composite black when printing at standard quality on plain paper or
envelopes.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

2. Click OK or Print to start printing.
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
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Checking Print Status - Windows
During printing, you can see the progress of your print job by accessing the Windows Desktop and
double-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up
arrow and double-clicking . Click Print Queue.

You can control printing using the options on the screen.
• To cancel printing, right-click on any print job and click Cancel.
• To pause printing, right-click on any print job and click Pause.
• To restart printing, right-click on any paused print job and click Restart.
Parent topic: Printing with Windows

Locking Printer Settings - Windows
Windows administrators can lock access to some printer settings to prevent unauthorized changes.
1. Do one of the following:

• Windows 11: Click , search for Settings and select it. Select Bluetooth & devices > Printers
& scanners. Select your product name and select Printer properties.

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.
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• Windows 7: Click and select Devices and Printers. Right-click your product and select
Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
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6. Click OK.
Locked Setting Options
Parent topic: Printing with Windows

Locked Setting Options
Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy
Pattern

Various data items Lets you select the data to use for the pattern or prohibit anti-
copy patterns

Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for

the custom anti-copy pattern
Watermark Various text

watermarks
Lets you select the text for the watermark or prohibit
watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, color and other watermark
settings

Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and

footers
Color Color Allows color printing

Grayscale Allows printing in black or shades of gray only
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Setting Options Description
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper
6-Up Allows printing of 6 pages on one sheet of paper
8-Up Allows printing of 8 pages on one sheet of paper
9-Up Allows printing of 9 pages on one sheet of paper
16-Up Allows printing of 16 pages on one sheet of paper

Parent topic: Locking Printer Settings - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
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You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
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1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
You see the printer settings window.

3. Click the Maintenance tab.
You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

3. Do one of the following:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Related tasks
Checking for Software Updates
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Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see a window like this:

4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

5. Click the Advanced button.
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You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.
12. Click OK to save your settings.

You see your application's Print window.
13. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S
Related references
Paper or Media Type Settings

Printing on a Mac
You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website or using Epson Software Updater.
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Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
Selecting Print Layout Options - Mac
Managing Color - Mac
Selecting Printing Preferences - Mac
Printing Your Document or Photo - Mac
Parent topic: Printing from a Computer

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the Show Details button to expand the print window.



77

You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.



78

6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Note: Paper sizes may include additional options such as Borderless.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings or Printer Features from the pop-up menu.

You see these settings:
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Note: The available print settings and appearance of the print window may be different than those
covered here, depending on the Mac OS version and the application you are using.

9. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

10. Select the Print Quality setting you want to use.
11. Select the Borderless checkbox if you want to print a borderless photo. If the option is grayed out,

change the Media Type setting to a paper type that supports borderless printing.
12. Select any of the available print options.
Print Quality Options - Mac
Print Options - Mac
Parent topic: Printing on a Mac
Related references
Paper or Media Type Settings
Related tasks
Selecting Page Setup Settings - Mac

Print Quality Options - Mac
You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.
Draft-Vivid

For draft printing on plain paper with good quality and print speed.
Normal

For everyday text and image printing.
Normal - Vivid

For everyday text and image printing with good quality and print speed.
Fine

For text and graphics with good quality and print speed.
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Quality
For text and graphics with increased quality and print speed.

Parent topic: Selecting Basic Print Settings - Mac
Print Options - Mac

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Expansion

If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to
Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.
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2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the Landscape setting.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac

Selecting Print Layout Options - Mac
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
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• To print on both sides of each page, select a setting from the Two-Sided pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing on a Mac

Managing Color - Mac
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.
3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
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Color Matching and Color Options - Mac
Parent topic: Printing on a Mac

Color Matching and Color Options - Mac
You can select these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer driver or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac
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Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.

You see a screen like this:

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac
Parent topic: Printing on a Mac

Printing Preferences - Mac
You can select these settings on the Options or Driver tab.
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Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

Bidirectional printing
Prints in both directions (right-to-left and left-to-right), speeding up printing, but may reduce print
quality.

Remove white borders
Removes white margins that may appear when you print borderless photos.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Checking Print Status - Mac
Parent topic: Printing on a Mac
Related tasks
Selecting Basic Print Settings - Mac

Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the
paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.
• To display other printer information, click Settings or Supply Levels.

Parent topic: Printing Your Document or Photo - Mac

Printing from a Smartphone or Tablet
You can print from a smartphone or tablet running iOS or Android using the Epson Smart Panel app.

Note: Your device must be connected to the same wireless network as your Epson product, and Epson
Smart Panel must be configured for use with your product.

1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See
the link below.

2. Open the Epson Smart Panel app and select a print menu on the home screen.
3. Follow the on-screen instructions to begin printing.
Parent topic: Printing from a Computer



88

Related tasks
Using the Epson Smart Panel Mobile App

Printing with Epson Photo+
You can print photos, CD/DVD labels, and more using a variety of layouts and templates with Epson
Photo+. Features include image corrections and adjustments, and adding text and stamps to photos. We
recommend printing on genuine Epson photo paper for the best results. Make sure you have set up your
product as described on the Start Here sheet and installed the Epson Photo+ software. See the Epson
Photo+ help utility for more information.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use
Epson Photo+. You also cannot download and install any Epson product software from the Epson
website for use with Windows 10 S; you must obtain software only from the Windows Store.

Parent topic: Printing from a Computer

Cancelling Printing Using a Product Button
If you need to cancel printing, press the stop button.
Parent topic: Printing from a Computer
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Scanning
You can scan your originals and save them as digital files.
Starting a Scan
Scanning a Document or Photo in Epson ScanSmart
Selecting Epson ScanSmart Settings
Scanning in Epson Scan 2

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.
Starting a Scan Using the Product Buttons
Starting a Scan Using Epson ScanSmart
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet
Parent topic: Scanning

Starting a Scan Using the Product Buttons
You can scan an image and save it as a PDF using your product's control panel buttons. You can
change the default scan settings using the Event Manager utility on the computer.
1. Make sure you installed the product software and connected the product to your computer using a

USB cable.
2. Place your original on the product for scanning.

3. Press the B&W copy button and the color copy button at the same time.
Your original is scanned and saved as a PDF on your computer.

Changing Default Scan Job Settings
Setting Up a WSD Port (Windows 7/Windows Vista)
Parent topic: Starting a Scan
Related tasks
Scanning in Epson Scan 2
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Changing Default Scan Job Settings
You can view or change the default scan job settings your product uses when you scan to your
computer. You do this using the Event Manager program.
1. Do one of the following to open Event Manager:

• Windows 11: Click , then search for Event Manager and select it.

• Windows 10: Click and select Epson Software > Event Manager.
• Windows 8.x: Navigate to the Apps screen and select Event Manager.

• Windows (other versions): Click or Start > All Programs or Programs > Epson Software >
Event Manager.

• Mac: Open the Applications folder, click Epson Software, and select Event Manager.
2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if

necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or

change.
5. Change the settings as necessary.
6. Click OK.
7. Click Close to close the Event Manager window.
Parent topic: Starting a Scan Using the Product Buttons

Setting Up a WSD Port (Windows 7/Windows Vista)
You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first
set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on
Windows 11, Windows 10 and Windows 8.x).
Before you set up a WSD port, make sure you installed your product software, and connected your
product and computer to the same network.
1. Turn on your product.
2. Print a network status sheet so you can identify the network name and model name for your product

on the network.

3. Click or Start and select Computer.
4. On the left side of the window, select Network.
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5. Locate your product on the Network screen, right-click it, and select Install.
6. When you see the User Account Control screen, click Continue.

Note: If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the
message.

8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then
click Close.

9. Do one of the following:

• Windows 7: Click and select Devices and Printers.
• Windows Vista: Click Start and select Control Panel > Hardware and Sound > Printers.

10. Make sure that an icon appears for your product's name on the network.
When you use WSD, select your product name to scan over the network.
Parent topic: Starting a Scan Using the Product Buttons

Starting a Scan Using Epson ScanSmart
You can start the Epson ScanSmart program to scan originals and easily review and edit scanned
images. After that, you can save, print, or share them.

• Windows 11: Click , then search for Epson ScanSmart and select it.

• Windows 10: Click > Epson Software > Epson ScanSmart.
• Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select Epson
Software > Epson ScanSmart.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson ScanSmart.



92

You see a screen like this:

Parent topic: Starting a Scan

Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 11: Click , then search for Epson Scan 2 and select it.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.
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• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan
Related tasks
Scanning in Epson Scan 2

Starting a Scan from a Smartphone or Tablet
You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection.
1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See

the link below.
2. Place your original on the product for scanning.
3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.
Parent topic: Starting a Scan
Related tasks
Using the Epson Smart Panel Mobile App

Scanning a Document or Photo in Epson ScanSmart
You can scan and review documents and photos in Epson ScanSmart.

Note: The images in this guide show Windows screens. Mac screens may be slightly different.
Depending on your product model and software version, not all options may be available.

1. Place your original on the product for scanning.
2. Open Epson ScanSmart on your computer. Do one of the following:

• Windows 11: Click , then search for Epson ScanSmart and select it.

• Windows 10: Click > Epson Software > Epson ScanSmart.
• Windows 8.x: Navigate to the Apps screen and select Epson ScanSmart.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Epson ScanSmart.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson
ScanSmart.
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You see a screen like this:

3. Select an option for the Scan area setting, if necessary.

Note: The Scan area setting limits the scan area to a selected size starting at the placement arrow
on the scanner bed. It does not scale the image to the selected size.

4. Select SCAN.
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The original is scanned. When scanning is complete, you see a screen like this:

Note: To change between document or photo editing options, select Change Mode.

5. In Document Editing Mode, you can review, edit, or reorder the scanned images as follows:
• Select + Scan to scan more originals.
• Select Delete to delete selected scanned images.
• Select Rotate Right to rotate each scanned image.
• Select Crop to crop the selected image.
• Control-click two images, select Stitch Images, and follow the on-screen instructions to combine

them into a single image.
6. In Photo Editing Mode, the following enhancement options are available:

• Auto Color Enhancement: automatically adjusts the brightness, contrast, and saturation of your
photos

• Restore Faded Colors: restores the colors in faded photos automatically
• Remove Red Eye: automatically removes the red-eye effect from your photos
• Auto Cropping: automatically crops the scanned image edges

7. When you finish reviewing and editing the scanned images, click Next.
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You see a screen like this:

8. Select an option to save, send, or print the scanned images. See the links below.
Saving a Scan
Attaching a Scan to Email
Sending a Scan to a Cloud Service
Printing a Scan
Parent topic: Scanning

Saving a Scan
You can save a scanned image to your computer in a variety of formats.
1. Make sure your originals are scanned and reviewed. See the link below.
2. In the Select Action window, click Save.
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You see a screen like this:

3. Change the settings as follows:
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• Select the folder on your computer in which to save the file.

4. Click Save.
Parent topic: Scanning a Document or Photo in Epson ScanSmart

Attaching a Scan to Email
You can attach a scanned image to an email as a file attachment.

Note: Your email app and account settings should be configured before scanning. You must install a
MAPI-type email program such as Outlook Express, Windows Live Mail, Entourage, or Mac Mail. Attach
to Email only supports 32-bit MAPI-compatible mail apps. Web-based email services such as Gmail are
not supported. If you see an error message, your email app may not be compatible and you will need to
save the scans and manually attach the file to an email.

1. Make sure your originals are scanned and reviewed. See the link below.
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2. In the Select Action window, click Attach to Email.
You see a screen like this:

3. Change the settings as follows:
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• If you also want to save a copy of the scanned image to your computer, make sure the checkbox

is selected and select the folder on your computer in which to save the file.
4. Click Attach to E-mail.

Your email program opens with the file attached to a new email.
Parent topic: Scanning a Document or Photo in Epson ScanSmart

Sending a Scan to a Cloud Service
You can upload scanned images to a cloud service.
1. Make sure your originals are scanned and reviewed. See the link below.
2. In the Select Action window, click one of the cloud service send options.
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You see a screen like this:

3. Log in to your account.

Note: You may need to allow Epson ScanSmart access to your account. The first time you log in,
you may be prompted to enter an authentication code.

4. Change the settings as follows:
• Select the folder in your account where you want to send the document.
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• If you also want to save a copy of the scanned image to your computer, click the checkbox.

5. Click Send.
Parent topic: Scanning a Document or Photo in Epson ScanSmart

Printing a Scan
You can print your scanned image and save the scanned file to your computer.
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Note: Printing scanned images is available only with Epson printers. If you do not have an Epson printer,
save the file and print it from an application that can open the file.

1. Make sure your originals are scanned and reviewed. See the link below.
2. In the Select Action window, click Print.

You see a screen like this:

3. Change the settings as follows:
• Select the Epson printer and change the print settings, if necessary.
• Select the number of copies you want to print.
• If you also want to save a copy of the scanned image to your computer, click the checkbox.
• The document type and scan date for the file name are automatically detected. You can change

them as necessary.
• You can save the scanned image in a variety of formats. If you select Searchable PDF as the File

type setting, you can select the OCR (Optical Character Recognition) language.
• Select the folder on your computer in which to save the file.

4. Click Print.
Parent topic: Scanning a Document or Photo in Epson ScanSmart
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Selecting Epson ScanSmart Settings
After starting Epson ScanSmart, you can change various scanning settings.
Changing the Epson Product
Changing the Scan Settings
Changing the File Name Settings
Changing the Save Settings
Save Settings
Customizing Action Icons
Parent topic: Scanning

Changing the Epson Product
If you are using more than one Epson product with Epson ScanSmart, you can change the product that
you are using with your computer.

Note: A product connected to your computer via USB takes priority over a product with a Wi-Fi
connection.

1. On the main screen, click Change.
You see a screen like this:
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2. Select the Epson product you want to use with your computer and click OK.
Parent topic: Selecting Epson ScanSmart Settings

Changing the Scan Settings
You can change detailed scan settings such as the resolution, document size, and more.

Note: If you select Auto Mode, you cannot change the scan settings.

1. Click the Settings button.
You see a screen like this:

2. Do one of the following:
• To change Document Mode settings, select Document Mode > Custom Settings.
• To change Photo Mode settings, select Photo Mode and click Close. When you start a scan, you

will be prompted to select scan settings.
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You see a screen like this:

3. Change the settings as necessary and click Save.
Parent topic: Selecting Epson ScanSmart Settings
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Changing the File Name Settings
You can change the default file naming method for your scans.

1. Click the Settings button.
You see a screen like this:

2. Click the File Name Settings tab.
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You see a screen like this:

3. Change the settings as necessary:
• Enter a prefix for the file name.
• Select the date format.
• Select a numbering format as the counter format.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Changing the Save Settings
You can change the file type options for saving your scans.

1. Click the Settings button.
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You see a screen like this:

2. Click the Save Settings tab.
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You see a screen like this:

3. Click Options for a file format and change the settings as necessary.
4. Click Open folder after saving to open the file folder after a file is saved.
5. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Save Settings
You can change the settings for how scanned images are saved.
PDF Options

Setting Options Description
General Generate PDF/A File Creates a PDF that conforms to

PDF/A-1 standards
Create file with all pages Saves all pages as one file
Compression Level Selects the compression level for color

or grayscale images
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JPEG Options

Setting Options Description
Image Quality Options — Sets a compression level by moving a

slider or entering a value. File size
increases the higher the resolution is.

Encoding (Windows only) Standard Images load from top to bottom in a
web browser. It takes longer to load the
entire image.

Progressive Images first load completely at low
resolution and then adjust to high
resolution in a web browser

Embed ICC Profile (Windows
only)

— Allows you to add ICC profiles to the
image

TIFF Options

Setting Options Description
Byte Order Windows

Macintosh
Specifies the operating system where
the scanned image will be used

Compression (Windows only) — Specifies the compression format and
level for Color/Grayscale and B&W
images. File size increases with higher
quality.

Embed ICC Profile (Windows
only)

— Allows you to add ICC profiles to the
image

Parent topic: Selecting Epson ScanSmart Settings

Customizing Action Icons
You can customize which scan action icons appear on the Select Action screen.

Note: You can also customize them by clicking the Customize icon on the Select Action screen.

1. Click the Settings button.
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You see a screen like this:

2. Click the Customize Actions tab.
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You see a screen like this:

3. Choose which action icons to display by selecting or deselecting each checkbox. Click the arrow
icons to move the icons up or down in the display order you want.

4. Click Close.
Parent topic: Selecting Epson ScanSmart Settings

Scanning in Epson Scan 2
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Start Epson Scan 2.
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You see this window:
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2. Select the Mode setting that matches the type of original you are scanning.
3. Select the Document Source setting that matches where you placed your original.
4. Select the Document Size setting that matches the size of your original. You can select Customize

to enter a custom size, if necessary.
5. Select the image type of your original and how you want it scanned as the Image Type setting.
6. Select the Resolution setting you want to use for your scan.
7. Select the Rotate setting to rotate the scanned image.
8. Select the Correct Document Skew setting to correct skewed originals, image contents, or both.
9. Click the Preview button.

Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

10. Do one of the following:
• If you're scanning in Document Mode, select any of the additional settings that you want to use on

the Main Settings tab.
• If you're scanning in Photo Mode, select the Color Management and Thumbnail Options

settings as necessary.
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11. Click the Advanced Settings tab and select any settings that you want to use.
12. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
13. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to

modify the file name settings.
14. Select the location in which you want to save your scanned file as the Folder setting. If necessary,

select Select to create a new folder.
15. Click Scan.

The product scans your original and saves the scanned file in the location you specified.
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Image Format Options
Scan Resolution Guidelines
Parent topic: Scanning

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Rotate

Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.

Parent topic: Scanning in Epson Scan 2
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Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Remove Background

Removes the background of the originals.
Text Enhancement

Sharpens the appearance of letters in text documents.
Auto Area Segmentation

Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Watermark
Adds a watermark to a scanned image.
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Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software from the CD included with your product. If you are downloading your product's
software, you must download and install the required Epson Scan 2 OCR Component to scan using
OCR with Epson Scan 2. Select Epson Software Updater in the Windows Start menu or Mac Epson
Software folder, and select the component and PDF extension files to download and install them.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. Select Searchable PDF as the Image Format setting.
6. Select Options from the Image Format list.
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You see this window:

7. Select any of the options on the General tab.
8. Select the Text tab.
9. Make sure the language used in the document text is selected as the Text Language setting.
10. Click OK.
11. Confirm the File Name setting and select a Folder setting for your document.
12. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning in Epson Scan 2

Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
BITMAP (*.bmp)

A standard image file format for most Windows programs.
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JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your
scans. Increasing the resolution raises the amount of detail captured but comes with the following
disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same
amount you will increase the image size to retain a high image quality. For example, if the resolution is
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300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600
dpi.

• You will scan the image at 100% or a smaller size.
Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2
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Refilling Ink
When the ink level is below the lower line on an ink tank, you need to refill it.
Periodically check the ink tanks to see if they need to be refilled.
Before checking the ink levels or refilling an ink tank as described here, be sure to read the ink safety
precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank.
Continued use of the product when the ink level is below the lower line on a tank could damage the
product.

Ink Safety Precautions
Checking Ink Levels on Your Product
Disabling Special Offers with Windows
Purchase Epson Ink
Refilling the Ink Tanks

Ink Safety Precautions
Ink Handling Precautions
• Keep ink bottles and the ink tanks out of the reach of children. Do not allow children to drink from or

handle the ink bottles and bottle caps.
• Do not tilt or shake an ink bottle after opening it; otherwise, ink may leak.
• Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink bottles or

ink bottle caps.
• If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them

immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
• Do not squeeze the ink bottles.
• If ink spills, wipe it up immediately. To prevent the ink from spreading, blot the spill with a dry cloth,

then wipe it with a damp cloth. The ink will be hard to remove once it has dried.

Ink Refilling Precautions
• Use ink bottles with the correct part number for this product.
• Do not mix with other Epson ink types.
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• This product requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled
with ink. If ink gets on your clothes or belongings, it may not come off.

• Do not open the ink bottle package until you are ready to fill an ink tank. Ink bottles are vacuum
packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print
quality may be affected.

• If the ink level is below the lower line on an ink tank, refill the ink. Continued use of the product when
the ink level is below the lower line on an ink tank could damage the product.

• Visually check the ink levels in the product’s ink tanks to confirm the actual ink levels. Continued use
of the product when the ink is below the lower line on an ink tank could damage the product.

• Do not maintain low ink levels for extended periods of time.
• Epson recommends filling all ink tanks to the upper line when the product is not operating.
• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for

at least three hours before using it.
• Use the ink bottle before the date printed on the package.
• After opening an ink bottle, Epson recommends using it as soon as possible.
• Wipe off any ink around the tanks and ports with a clean, lint-free cloth or cotton swab.
• Store ink bottles in a cool, dark place. Keep them out of direct sunlight.
• Do not store the ink bottles in high or freezing temperatures.
• Store the ink bottles in the same environment as the product. When storing or transporting an opened

ink bottle, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink
may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright
when tightening the cap, and take measures to prevent ink from leaking when you transport the bottle.

Ink Bottle and Ink Tank Information
• To maintain optimum print head performance, some ink is consumed from all ink tanks during printing

and when performing maintenance operations, such as cleaning the print head. Ink may also be
consumed when the product is turned on.

• Quoted ink yields may vary depending on the images you are printing, the paper type you are using,
how often you print, and environmental conditions such as temperature.

• The ink bottles may contain recycled materials, but this does not affect product function or
performance.

• The specification and appearance of the ink bottles are subject to change without prior notice for
improvement.
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• When printing in monochrome or grayscale, color ink may be used instead of black ink, depending on
the paper type or print quality settings. This is because a mixture of color inks is used to create black.

Parent topic: Refilling Ink

Checking Ink Levels on Your Product
To confirm the actual ink levels, visually check the ink levels in the product’s ink tanks. Make sure the ink
levels are above the lower lines on the ink tanks. If any of the ink tanks are below the lower line, fill them
up to the upper line on the ink tank.

Parent topic: Refilling Ink
Related references
Ink Safety Precautions
Related tasks
Refilling the Ink Tanks

Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click . Select Monitoring Preferences.
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You see this window:

2. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Refilling Ink
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Purchase Epson Ink
You can purchase genuine Epson ink and paper at epson.com (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Note: Epson's warranties do not extend to any damage caused by the use of third-party ink or ink not
designed for your printer.
The included initial ink bottles must be used for printer setup and are not for resale. The printer ships
with full ink bottles and part of the ink from the first bottles is used to charge the print head. Yields vary
considerably based on images printed, print settings, paper type, frequency of use and temperature.

Ink Bottle Part Numbers
Parent topic: Refilling Ink

Ink Bottle Part Numbers
Use these part numbers when you order or purchase new ink bottles.

Ink color Part number
Black 522120
Cyan 522220
Magenta 522320
Yellow 522420

Parent topic: Purchase Epson Ink

Refilling the Ink Tanks
Make sure you have new ink bottles handy and have read the ink safety precautions before you begin.
You can continue to use the product even if one or more ink tanks are not filled all the way.

Caution: Wear disposable gloves while refilling the ink tanks to avoid staining your hands. If ink spills,
wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your clothes or
belongings, it may not come off.

https://www.epson.com
https://www.epson.ca
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1. Open the ink tank cover.

2. Open the cap for the ink tank you are going to fill.

Note: Make sure the color of the ink tank label matches the ink color you want to fill.
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3. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after removing its
cap.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Seek medical advice if problems persist. Keep the ink bottles out of the reach of children and do not
drink the ink.

4. Check the upper line (a) on the ink tank.
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5. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the bottle
up to insert it. Wait for the ink to fill the tank. Do not squeeze the bottle. Ink flows into the tank and
stops automatically when the ink is filled to the upper line.

Note: Do not force the bottles into position; they are keyed for each color.
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Note: If ink does not flow from the bottle, lift and reinsert the bottle. However, do not remove and
reinsert the ink bottle when the ink has reached the upper line; otherwise ink may leak.

6. When the ink tank is full, remove the ink bottle and securely close the ink tank cap as shown.

Note: Do not leave the ink bottle inserted; otherwise the bottle may be damaged or ink may leak.

Note: If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for
later use.
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7. Repeat the previous steps as necessary for each ink tank you need to fill.
8. Close the ink tank cover.

Parent topic: Refilling Ink
Related concepts
Purchase Epson Ink
Related references
Ink Safety Precautions
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the
paper path.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path
Checking the Number of Sheets Fed

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may
have to refill the ink tank first.

If you still see white or dark lines or gaps in your printouts, even after cleaning the print head several
times, you can run a Power Cleaning.
Print Head Nozzle Check
Print Head Cleaning
Power Cleaning
Parent topic: Adjusting Print Quality
Related topics
Refilling Ink

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Buttons
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance
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Checking the Nozzles Using the Product Buttons
You can check the print head nozzles using the buttons on your product.
1. Press the power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the stop button and press the power button to turn the product on.
4. When the product turns on, release both buttons.

The product prints a nozzle check pattern.

Note: It can take a few seconds for the nozzle check pattern to start printing. If it does not start
printing after a few seconds, make sure there is paper loaded in the product.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

6. Do one of the following:
• If there are no gaps, the print head is clean and you can continue printing.
• If there are gaps or the pattern is faint, clean the print head.
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• If almost the entire pattern is missing, see the link below for instructions on performing a Power
Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not
improve, run a Power Cleaning.
Parent topic: Print Head Nozzle Check
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Sheet Feeder
Cleaning the Print Head Using the Product Buttons

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in the product.
2. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Nozzle Check or Print Head Nozzle Check.
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You see a window like this:

4. Click Print.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

6. Do one of the following:
• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, clean the print head.
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• If almost the entire pattern is missing, click Finish and perform a Power Cleaning.
If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not
improve, run a Power Cleaning.
Parent topic: Print Head Nozzle Check
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Sheet Feeder
Cleaning the Print Head Using a Computer Utility

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may
have to refill the ink tank first.

Cleaning the Print Head Using the Product Buttons
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related topics
Refilling Ink

Cleaning the Print Head Using the Product Buttons
You can clean the print head using the buttons on your product.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Hold down the stop button for five seconds to start the cleaning cycle.

The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.
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4. Run a nozzle check to confirm that the print head is clean.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

5. Do one of the following:
• If there are no gaps, the print head is clean and you can continue printing.
• If there are gaps or the pattern is faint, clean the print head.
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• If almost the entire pattern is missing, see the link below for instructions on performing a Power
Cleaning.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then try cleaning the print head again. If quality still does not improve, run a Power
Cleaning. If there is still no improvement, contact Epson support.
Parent topic: Print Head Cleaning
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Sheet Feeder
Checking the Nozzles Using the Product Buttons

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure no product lights are indicating errors.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning or Print Head Cleaning.
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You see a window like this:

5. Click Start to begin the cleaning cycle.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Print head needs Power Cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.
• If almost the entire pattern is missing, click Finish and perform a Power Cleaning.
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If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait
at least 12 hours. Then check the print head nozzles and try cleaning the print head again. If quality still
does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.
Parent topic: Print Head Cleaning
Related concepts
Power Cleaning
Related tasks
Loading Paper in the Sheet Feeder
Checking the Nozzles Using a Computer Utility

Power Cleaning
If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head
several times, you can run a Power Cleaning.
If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12
hours before running another Power Cleaning.

Caution: Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make
sure each ink tank is at least one-third full before running a Power Cleaning, or it may damage the
product.

Caution: Power Cleaning may cause the ink pads to reach their capacity sooner. When an ink pad
reaches the end of its service life, the product stops printing and you must contact Epson for support.

Power Cleaning Using a Computer Utility
Parent topic: Print Head Maintenance
Related topics
Refilling Ink

Power Cleaning Using a Computer Utility
You can run a Power Cleaning using a utility on your Windows or Mac computer.

Note: After running a Power Cleaning, you must turn off the product and wait at least 12 hours before
running another Power Cleaning.

1. Make sure no product lights are indicating errors.
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2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click . Select Printer Settings and
click the Maintenance tab.

• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Power Cleaning.
You see a window like this:

5. Follow the on-screen instructions to run a Power Cleaning.
6. When Power Cleaning is finished, run a nozzle check.
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If print quality has not improved after running Power Cleaning, wait for at least 12 hours without printing,
and then print the nozzle check pattern again. Run Print Head Cleaning or Power Cleaning again
depending on the printed pattern. If quality still does not improve, contact Epson support.
Parent topic: Power Cleaning
Related concepts
Print Head Nozzle Check
Related references
Product Light Status
Related tasks
Loading Paper in the Sheet Feeder

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality
Related concepts
Print Head Cleaning
Related tasks
Loading Paper in the Sheet Feeder

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows or Mac computer.
1. Load a few sheets of plain paper in the product.
2. Do one of the following:

• Windows: Access the Windows Desktop and right-click the icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click .
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• Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Print Head Alignment.
4. Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:
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5. Check the printed pattern and follow the instructions on the screen to choose the number of the best
printed pattern for each set.
Vertical alignment

Horizontal alignment

• After choosing a pattern number, click Next.
• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click

Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

6. When you are done, click Finish.
Parent topic: Print Head Alignment
Related tasks
Loading Paper in the Sheet Feeder

Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

Caution: Do not use tissues to clean the rollers inside the product; lint from tissue may clog the print
head nozzles.
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1. Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.

Note: Make sure there is no dust or stains on the scanner glass or document cover.

3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
Related tasks
Loading Paper in the Sheet Feeder
Related topics
Copying

Checking the Number of Sheets Fed
You can view an option that displays the number of sheets of paper that have fed through the product.

Note: You can also view the number of sheets of paper fed through the product by printing a nozzle
check.

Checking the Sheet Counter - Windows
Checking the Sheet Counter - Mac
Parent topic: Adjusting Print Quality

Checking the Sheet Counter - Windows
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.
3. Click the Maintenance tab.
4. Select Printer and Option Information.
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You see this window:

5. After checking the number of sheets fed into the printer, click OK to close the window.

Note: The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

Parent topic: Checking the Number of Sheets Fed

Checking the Sheet Counter - Mac
You can check the number of sheets of paper that have fed through the product by checking the sheet
counter.
1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select Printer and Option Information.
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You see this window:

3. After checking the number of sheets fed into the printer, click OK to close the window.
Parent topic: Checking the Number of Sheets Fed
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Cleaning and Transporting Your Product
See these sections if you need to clean or transport your product.
Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year. Close the output tray,
front cover, and rear paper feed cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, dry cloth. If the glass is stained with grease or some other

material, use a small amount of glass cleaner and a soft cloth to remove it. Wipe off all remaining
liquid.

Caution: Do not press the glass surface with any force. Be careful not to scratch or damage the
surface of the glass.

Caution: Be careful not to get water onto the printer mechanism or any electrical components.
Otherwise, the printer could be damaged.

6. Clean the outer case and control panel with a soft, clean cloth that has been dampened with water. If
you cannot remove the dirt, try adding a small amount of mild soap to the damp cloth.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to store your product or transport it some distance, prepare it for transportation as described
here.
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Caution: During transportation and storage, follow these guidelines:
• When storing or transporting the printer, place the printer in the plastic bag and fold it closed.
• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not
subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle
is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take
measures to prevent ink from leaking when transporting the ink bottles.
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• Do not put opened ink bottles in the box with the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Note: Make sure the print head is capped properly to prevent the ink from drying.

1. Turn off the product.
2. Open the front cover and check to see if the print head is in the far right position (the home position).

If not, turn on the product, wait for the print head to move to the far right, then turn the product off
again.

3. Make sure the power light turns off, and then unplug the power cable.
4. Disconnect any connected cables.
5. Remove all the paper.
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6. Open the ink tank cover and make sure that the ink tank caps are securely closed as shown.

7. Close the ink tank cover.
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8. Close the paper support, feeder guard, and output tray.

9. Place the printer in the plastic bag and fold it closed. Pack the printer in its box using the protective
materials.

If print quality has declined when you print again, clean and align the print head.
Parent topic: Cleaning and Transporting Your Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Product Light Status
Running a Product Check
Resetting Network Settings
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
It's a good idea to check Epson's support website occasionally for free updates to your product software.
Visit epson.com/support (U.S.) or epson.ca/support (Canada) and select your product.
• Windows: Your printer software automatically checks for updates. You can also manually update the

software by selecting Software Update here:

• Accessing the Windows Desktop and right-clicking the icon for your product in the right side of
the Windows taskbar, or clicking the up arrow and right-clicking .

• On the Maintenance tab in the printer settings window
You can also update the software by selecting EPSON Software Updater in the EPSON or Epson
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

• OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

http://www.epson.com/support
http://www.epson.ca/support
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• macOS 10.12.x, 10.13.x, 10.14.x, 10.15.x, 11.x, or 12.x: You can manually update the software by
opening the App Store, selecting Updates, searching for a software update option for Epson
Software, and selecting Update.

Parent topic: Solving Problems
Related tasks
Changing Automatic Update Options

Product Light Status
You can often diagnose problems with your product by checking its lights.

1 power light
2 Wi-Fi light
3 Wi-Fi Direct light
4 ink light
5 paper light

Light status Condition/solution
The power light is flashing The product is busy. Wait for the power light to stop flashing before

turning off the product.

The ink light is on Initial ink charging may not be complete. See the Start Here sheet for
instructions.
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Light status Condition/solution
The paper light is on No paper is loaded or multiple sheets fed at one time. Load paper in the

product, and press the B&W copy button or the color copy button
to clear the error.

The paper light is flashing Paper is jammed in the product. Remove the jammed paper, and press
the B&W copy button or the color copy button to clear the error.

The ink and paper lights
are flashing simultaneously

An ink pad is nearing or at the end of its service life. Contact Epson for
support. If a message to continue printing appears on your computer,
press the B&W copy button or the color copy button to continue
printing.

The ink and paper lights
are flashing alternately

A borderless printing ink pad is nearing or at the end of its service life.
Contact Epson for support. If a message to continue printing appears on
your computer, press the B&W copy button or the color copy
button to continue printing. Borderless printing is not available until the
ink pad is replaced.

All lights are flashing A printer error has occurred. Paper or protective material is stuck inside
the product. Open the front cover and remove any jammed paper or
protective materials. Turn the product off and then back on again. If the
error continues, contact Epson for support.

The Wi-Fi and Wi-Fi
Direct lights are flashing

A Wi-Fi connection error has occurred. Press the Wi-Fi button to clear
the error and try again.

The ink light is on
The paper light is on
The Wi-Fi and Wi-Fi
Direct lights are on

An error has occurred during firmware updating. Connect your product
using a USB cable and try updating the firmware again. If the error
continues, contact Epson for support.

The ink light is on
The paper light is on

The product was not turned off correctly. Press the B&W copy button
or the color copy button to clear the error, then run a nozzle check
and cancel any pending print jobs. Always use the power button to
turn off the product.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD screen, or lights on the control panel will advise you when these parts need replacing. If this
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happens during the standard warranty of the product, the exchange of the product or replacement of the
pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced
by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems
Related concepts
Print Head Nozzle Check
Related references
Paper Jam Problems
Related tasks
Loading Paper in the Sheet Feeder
Related topics
Wi-Fi Networking

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Press the power button to turn the product off.
2. Load a few sheets of plain paper in the product.
3. Hold down the stop button and press the power button to turn the product on.
4. When the product turns on, release both buttons.

The product prints a nozzle check pattern.

Note: It can take a few seconds for the nozzle check to start printing. If the nozzle check does not
start printing after a few seconds, make sure there is paper loaded in the printer.
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5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

6. Do one of the following, depending on the results of the product check:
• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page prints but almost the entire nozzle check pattern is missing, perform a Power Cleaning.
• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
Print Head Cleaning
Print Head Alignment
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Uninstall Your Product Software
Power Cleaning

Resetting Network Settings
You can reset the network settings to their factory defaults.
1. Turn off your product.

2. Hold down the network status button and press the power button until the Wi-Fi light and
Wi-Fi Direct light flash alternately. Then release both buttons.

When the Wi-Fi light and Wi-Fi Direct light turn off, the Wi-Fi settings are reset.
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Product Does Not Turn On or Off
Noise After Filling the Ink
Software Installation Problems
Parent topic: Solving Problems

Product Does Not Turn On or Off
If you cannot turn the product on or off, try these solutions:
• If you cannot turn on your product, make sure the power cord is securely connected and hold down

the power button a little longer.
• If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off

your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Filling the Ink
If you hear noises from your product after filling the ink tanks with ink, check these explanations:
• The first time you fill the tanks with ink, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on. Your product is finished charging the print head when the power light stops flashing.
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• If the product's ink light is on, the charging process may not be complete. Wait until charging finishes
before you turn off the product, or it may charge improperly and use excess ink the next time you turn
it on.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 20 minutes, turn off your product. Turn it back on and check to see if charging is
still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related topics
Refilling Ink

Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and any necessary cables are securely connected at both ends. If

you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

• If you are printing over a network, make sure your product is set up properly on the network.
• If the USB cable is not recognized, try using a different USB cable.
Parent topic: Solving Setup Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.
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Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac Printer Window
Wireless Network Connection is Unstable on a Mac
Cannot Print Over a Network
Cannot Scan Over a Network
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi light on your

product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of
pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• Print a network connection report and check the codes and messages on the report to help determine
the cause of the problem.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Try restarting your router following the instructions in your router documentation.
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Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. Then
follow the instructions in your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• Turn off the devices you want to connect to the network. Wait for about 10 seconds and then turn on
the devices in the following order: wireless router, computer or smart device, and then your product.
Move your product and computer or smart device closer to the wireless router to help with radio wave
communication, and then try to make network settings again.

• If the IP address assigned to the product is 169.254.XXX.XXX and the subnet mask is 255.255.0.0,
the IP address may not be assigned correctly. Check the IP address and the subnet mask assigned to
the product. Restart the wireless router or reset the network settings for the product.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi Direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Related tasks
Enabling Wi-Fi Direct Mode
Using WPS to Connect to a Network
Printing a Network Status Sheet
Resetting Network Settings
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Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify the connection using your

product control panel.
• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-

ASCII characters.
• Print a network connection report and check the codes and messages on the report to help determine

the cause of the problem.
• Make sure your product is not connected to a guest network.
• If necessary, reinstall your product software and try running EpsonNet Setup again:

1. Reset your product's network settings to their factory defaults.
2. Windows only: Uninstall your product software.
3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

• Try accessing any website from your computer to make sure that your computer's network settings are
correct. If you cannot access any website, there is a problem on the computer. Check the network
connection of the computer. See the documentation provided with the computer for details.

Parent topic: Solving Network Problems
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Related concepts
Uninstall Your Product Software
Related tasks
Enabling Wi-Fi Direct Mode
Using WPS to Connect to a Network
Printing a Network Status Sheet
Resetting Network Settings
Connecting to a New Wi-Fi Router

Product Does Not Appear in Mac Printer Window
If your product does not appear in the Mac printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi light on your

product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of
pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi light on your product
is not solid green, make sure your product software was installed correctly. If necessary, reinstall your
software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Enabling Wi-Fi Direct Mode
Using WPS to Connect to a Network

Wireless Network Connection is Unstable on a Mac
If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network
interference between your product and your Mac.
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If you cannot connect to your product over the wireless network or the connection becomes unstable,
move the device connected to your Mac USB 3.0 port further away from your Mac.
Parent topic: Solving Network Problems

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Make sure that the latest version of your product's Epson printer driver is installed. If a genuine Epson

printer driver is not installed, the available functions are limited.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• Print a network connection report and check the codes and messages on the report to help determine

the cause of the problem.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point. Avoid placing your product near a microwave oven,
cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
restart your router.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.
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• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi light on your
product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of
pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• If you are printing a large data size image, the computer may run out of memory. Print the image at a
lower resolution or a smaller size.

Parent topic: Solving Network Problems
Related concepts
Uninstall Your Product Software
Related tasks
Enabling Wi-Fi Direct Mode
Using WPS to Connect to a Network
Printing a Network Status Sheet

Cannot Scan Over a Network
If you have problems scanning over a network, try these solutions:
• Make sure you are scanning from a computer. If you want to scan from your product control panel, you

must connect the product to your computer with a USB cable.
• Check the scanning setting assigned in Epson Event Manager.
• If you are scanning a large original at a high resolution, a network communication error may occur. Try

scanning again at a lower resolution.
• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few

seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan 2 again.

• Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

Windows 11: Click , then search for Epson Scan 2 Utility and select it. Make sure your product is
selected. If necessary, select the Other tab and click Reset.

Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure your product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen, select EPSON, and select Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.
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Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure your product is selected. If necessary, select the Other tab and click Reset.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Parent topic: Solving Network Problems
Related topics
Wi-Fi Networking
Starting a Scan

Solving Copying Problems
Check these solutions if you have problems copying with your product.
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Copies Have Incorrect or Faint Colors
Position, Size, or Margins of Copies are Incorrect
Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product

software is installed correctly.
• Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Copies Have Incorrect or Faint Colors
If your copies have incorrect, uneven, smeared, or faint colors, try these solutions:
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Do not press too hard on the original when you copy from the scanner glass.
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Wipe any dirt or dust off of your originals.
• Make sure your paper is not curled.
• When vertical banding appears or the paper is smeared, clean the paper path.
• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the

correct direction and slide the edge guides to the edges of the paper.
Parent topic: Solving Copying Problems

Position, Size, or Margins of Copies are Incorrect
If the position, size, or margins of your copies are incorrect, try these solutions:
• When placing originals on the scanner glass, make sure the original is placed correctly for scanning.

Align the corner of the original with the corner indicated by the symbol on the scanner glass. If
necessary, move the original away from the edges of the scanner glass slightly.

• Make sure the paper is loaded in the correct direction.
Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.
Paper Feeding Problems
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Paper Jam Problems
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• Place the product on a flat surface.
• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feed. Slide

the edge guide against the edge of the paper, making sure that the paper stack is not above the arrow
mark on the edge guide.

• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If multiple pages feed at once during manual 2-sided printing, remove any paper from the product

before reloading paper.
• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not load

more than the recommended number of sheets.
• Do not load more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• Try cleaning the paper path.
• Do not place objects on the feeder guard.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the rear paper feed printable side up.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
Related references
Paper Loading Capacity
Paper Jam Problems
Related tasks
Loading Paper in the Sheet Feeder
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Paper Jam Problems
If you have problems with paper jams, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Gently pull out any jammed paper from the rear paper feed slot.

3. Open the front cover.
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4. Open the scanner unit until it clicks.

Caution: Do not touch the parts shown here or you may damage the product.
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Caution: Never touch the buttons on the control panel while your hand is inside the printer. If the
printer starts operating, it could cause an injury. Be careful not to touch the protruding parts to avoid
injury.

5. Gently remove any jammed paper.
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Caution: When removing jammed paper, avoid tilting the printer, placing it vertically, or turning it
upside down; otherwise ink may leak.

6. Close the scanner unit.

7. Close the front cover.

8. Carefully follow all paper loading instructions when you load new paper.
Parent topic: Solving Paper Problems



177

Related tasks
Cancelling Printing Using a Product Button
Loading Paper in the Sheet Feeder

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings
Related tasks
Cancelling Printing Using a Product Button
Loading Paper in the Sheet Feeder

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on and connected to your computer.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• If your computer is connected using a USB cable, try a different USB port on your computer or a

different cable.
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• Make sure the printer status is not offline or pending.
• Make sure you are using the Epson printer driver for your product or the available functions are

limited.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. Print the image at a lower
resolution or if necessary, increase your system's memory.

• In Windows, make sure your product is selected as the default printer and the printer port setting
matches the printer connection port.

• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

• In Windows, do one of the following to open the Epson Printer Connection Checker and follow the on-
screen instructions to check the connection status:

• Windows 11: Click , then search for Epson Printer Connection Checker and select it.

• Windows 10: Click and select Epson Software > Epson Printer Connection Checker.
• Windows 8.x: Navigate to the Apps screen and select the Epson Printer Connection Checker

icon.

• Windows 7: Click and select All Programs > Epson Software > Epson Printer Connection
Checker.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.
• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check
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Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 11: Click , search for Settings and select it. Select Bluetooth & devices > Printers
& scanners. Select your product name and select Printing preferences.

• Windows 10: Click and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

• Windows 7: Click and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

2. Click the Maintenance tab.
3. Click the Extended Settings button.
4. Select Enable EPSON Status Monitor 3 and click OK.
5. Click the Monitoring Preferences button.
6. Click the checkbox for the option that adds the shortcut icon to the taskbar.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
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• On a Mac, make sure you download and install the Epson printer driver.
• Make sure Quiet Mode is turned off.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

• If you are printing over a wireless network, factors such as interference, network traffic, or weak signal
strength may affect your printing speed.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,

and select the following settings:
• Always Spool RAW Datatype
• Page Rendering Mode
• Print as Bitmap

• Windows: Select Printing preferences, click the More Options tab, and make sure the
Bidirectional printing setting is enabled.

• Mac: Select System Preferences, select Printers & Scanners, and select your product. Select
Options & Supplies, select Options (or Driver), and enable the Bidirectional printing setting.



181

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems
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Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Print Layout Options - Mac

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software, if available.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
• You may need to refill the ink. Visually check the ink levels.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related references
Paper or Media Type Settings
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Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the product.
• When placing originals on the scanner glass, align the corner of the original with the corner indicated

by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.
• Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area

may extend to include the dust or stains.
• Load paper in the correct direction and slide the edge guides against the edges of the paper.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
• Make sure you are printing on a compatible borderless paper type and size.
• Windows: Make sure you selected the Borderless setting in your printer software.
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• Mac: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in
your printer software.

• Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

• Access the Extended Settings (Windows) or Printing Preferences (Mac) and select Remove White
Borders.

Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings
Print Options - Mac
Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in

the printer settings window, and cancel any stalled print jobs.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If incorrect characters still appear in your prints, try connecting your product using a different cable.
• If your computer entered sleep mode the last time you printed, the next print job after your computer

exits sleep mode may contain garbled characters. Print your document again.
• Make sure you are using the printer software for this product. Check the product name at the top of the

driver window.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
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Selecting Extended Settings - Windows

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure your paper is positioned correctly for feeding into the printer.
• Slide the edge guides against the edges of the paper.
• Clean the scanner glass and document cover.
• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner

glass.
• Make sure you selected the correct margins for your paper size in your printing program.
• If the image is slightly enlarged and cropped during borderless printing, change the Expansion

setting.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related references
Paper or Media Type Settings
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Placing Originals on the Scanner Glass
Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
• Make sure your paper meets the specifications for your product.
• Do not load more than the recommended number of sheets.
• Slide the edge guides against the edges of the paper.
• Select a higher print quality setting in your printer software.
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• Turn off any high speed settings in your product software.
• Align the print head.
• Adjust the print quality.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head. If print quality does not improve after aligning the print head, disable the

bidirectional (high speed) setting.
• Adjust the print quality in the product software.
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• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the
correct direction and slide the edge guides to the edges of the paper.

• When vertical banding appears or the paper is smeared, clean the paper path.
• You may need to refill the ink. Visually check the ink levels.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning
Related references
Paper or Media Type Settings
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper
Refilling Ink

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Slide the edge guides to the edges of the paper.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
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• Do not load more than the recommended number of sheets. For plain paper, do not load above the
line indicated by the triangle symbol on the edge guide.

• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• If you are printing on thick paper or envelopes, make sure you select the appropriate settings. In

Windows, you can also try selecting Short Grain Paper in Extended Settings.
• When manually printing 2-sided, make sure the ink is completely dry before loading the paper.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• When vertical banding appears or the paper is smeared, clean the paper path.
• When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the

correct direction and slide the edge guides to the edges of the paper.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the density and/or ink drying time settings.

• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Adjust the print quality in the product software.
• Clean the paper path.
• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to

the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has
improved.

• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
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Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Power Cleaning
Related references
Paper or Media Type Settings
Compatible Epson Papers
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cleaning the Paper Path
Related topics
Loading Paper
Refilling Ink

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink levels may be low. Visually check the ink levels.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Adjust the print quality in the product software.
• Clean the paper path.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.
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• If you cannot solve the problem using head cleaning, you can print immediately from a Windows
computer with a mixture of color inks to create composite black. Select the Use a Mixture of Color
Inks to Create Black setting from Extended Settings on the printer driver's Maintenance tab. You
can print at Standard print quality when the Paper Type is Plain Paper / Bright White Paper,
Letterhead, or Envelope.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Cleaning the Paper Path
Related topics
Loading Paper
Refilling Ink

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Adjust the print quality in the product software.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.
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• If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the paper type setting matches the paper you loaded.
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• If you selected Standard-Vivid (Windows) or Normal-Vivid (Mac) as the quality setting in the printer

software, try selecting Standard (Windows) or Normal (Mac) instead.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors

may look different than you expect. To speed up drying time, do not stack your printouts on top of each
other.
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• Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

• Select Custom as the Color Correction setting on the More Options tab of the printer software, then
click Advanced. Try selecting a different Color Management setting.

• For best results, use genuine Epson paper.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality
by cleaning the print head.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Power Cleaning
Related references
Paper or Media Type Settings
Compatible Epson Papers
Related tasks
Checking Ink Levels on Your Product
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Related topics
Refilling Ink

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Scanning is Slow
Parent topic: Solving Problems
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Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, make sure your product is listed as a valid device in the Scanners and Cameras control

panel.
• Try scanning at a lower resolution or increase the free space on the computer's hard disk. Scanning

stops if the total data size reaches the limit.
• Use the Epson Scan 2 Utility on your computer to reset the scanner software settings. If resetting the

settings does not solve the problem, uninstall and reinstall the scanner software.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your product is turned on and any interface cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:

Windows 11: Click , search for Epson Scan 2 Utility and select it. Make sure the correct product
is selected. If necessary, select the Other tab and click Reset.
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Windows 10: Click and select EPSON > Epson Scan 2 Utility. Make sure the correct product is
selected. If necessary, select the Other tab and click Reset.
Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct
product is selected. If necessary, select the Other tab and click Reset.

Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson Scan
2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other
tab and click Reset.
Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make
sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both
versions and install one version.

• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Product Software
Related topics
Starting a Scan

Scanning is Slow
If scanning becomes slow, try these solutions:
• Scan your original at a lower resolution, if possible.
• Make sure your system meets the requirements for your operating system. If you are scanning a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

• In Epson Scan 2, open the Configuration screen and turn off Quiet Mode on the Scan tab.
Parent topic: Solving Scanning Problems

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.
Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked
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Scanned Image Quality Problems
Characters are Not Recognized During Conversion to Editable Text (OCR)
Image Colors are Patchy at the Edges
Ripple Patterns Appear in an Image
Scanned Image Edges are Cropped
Resetting the Epson Scan 2 Settings
Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
• Make sure you placed your original for scanning facing the correct way.
• Make sure you select the correct Image Type for your original.
• Remove any lint or dirt from your original.
• Clean the scanner glass.
• Do not press on the original or the document cover with too much force.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Related tasks
Placing Originals on the Scanner Glass

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.
• Remove any dust or dirt that may have adhered to your original.
• Do not press with too much force on the original or the document cover.
• Keep the document cover closed to prevent dirt or dust from getting inside.
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Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.
Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the
cloth, if necessary. Paper towels are not recommended.
Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Scanned Image Quality Problems
If you encounter quality problems with your scanned image, try these solutions:

Image is Distorted or Blurry
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the

scanner glass.
• Do not move your original or your product during scanning.
• Do not press on the document cover or the original with too much force.
• Your product will not operate properly while tilted at an angle. Place your product on a flat, stable

surface that extends beyond its base in all directions.
• Adjust these Epson Scan 2 or Epson ScanSmart settings (if available) and try scanning again:

• Increase the Resolution setting.
• If the Image Type setting is Black & White, adjust the Threshold setting.
• If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
• If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is

Color or Grayscale, change the Text Enhancement setting to High.



197

Image is Too Dark
• If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
• Check the brightness and contrast settings of your computer monitor.

Back of Original Image Appears in Scanned Image
• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 or Epson ScanSmart settings (if available) and try scanning again:

• Select the Advanced Settings tab and adjust the Brightness setting.
• If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to

Color or Grayscale, change the Text Enhancement setting to High.
• Select Text Enhancement.

Note: The Text Enhancement and Remove Background settings depend on the selected Image
Type.

Scanned Image Colors Do Not Match Original Colors
Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).
Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these Epson Scan 2 or Epson ScanSmart settings (if
available) and try scanning again:
• If the Image Type setting is Color or Grayscale, adjust the Contrast setting.
• If the Image Type setting is Black & White or Grayscale, adjust the Color Enhance setting.
Parent topic: Solving Scanned Image Quality Problems

Characters are Not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:
• Make sure your original is loaded straight on your product.
• Use an original with clear text.
• When saving scanned images as Searchable PDFs, make sure the correct OCR language is selected.
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• Adjust the following Epson Scan 2 settings if available, and try scanning again:
• On the Main Settings tab, make sure you select the correct Image Type for your original.
• On the Main Settings tab, set the Resolution between 200 and 600 dpi.
• On the Advanced Settings tab, select Text Enhancement and choose a setting.

Note: The Text Enhancement setting depends on the selected Image Type.

• If the Image Type is set to Black & White, adjust the Threshold setting on the Advanced Settings
tab. (The Image Option must be set to None.)

Parent topic: Solving Scanned Image Quality Problems

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.
Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
In the Epson Scan 2 or Epson ScanSmart settings, set the Edge Fill setting to None.
When scanning using Epson ScanSmart and placing multiple originals on the scanner glass, make sure
there is a gap of at least 0.8 in. (20 mm) between the originals.
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Parent topic: Solving Scanned Image Quality Problems
Related tasks
Placing Originals on the Scanner Glass

Resetting the Epson Scan 2 Settings
If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.
1. Do one of the following to start the Epson Scan 2 Utility:

• Windows 11: Click , then search for Epson Scan 2 Utility and select it.

• Windows 10: Click > EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-
install it.

Parent topic: Solving Scanned Image Quality Problems

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Product Software - Windows
Uninstalling Product Software - Mac
Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
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1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

• Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

• Windows 10: Click and select (Settings) > Apps or System > Apps & features. Then
select the program you want to uninstall and select Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:

• Windows 11/Windows 10/8.x: Select Epson Event Manager and click Uninstall.
• Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and

Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
• Windows 11/Windows 10: Select Epson Scan 2 and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson Scan 2 and click Uninstall/Change.

6. Do one of the following to uninstall Epson ScanSmart, then follow any on-screen instructions:
• Windows 11/Windows 10: Select Epson ScanSmart and click Uninstall.
• Windows 8.x/Windows 7/Windows Vista: Select Epson ScanSmart and click

Uninstall/Change.
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7. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit and select your product.
2. Click Downloads.
3. Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
4. Run the file you downloaded.
5. Double-click the Uninstaller icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
7. Click Uninstall.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.
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Internet Support
Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) and select
your product for solutions to common problems. You can download drivers and documentation, get
FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-4382, 7 AM to 4 PM, Pacific Time, Monday through Friday
• Canada: (905) 709-3839, 7 AM to 4 PM, Pacific Time, Monday through Friday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
Parent topic: Solving Problems

http://www.epson.com/support
http://www.epson.ca/support
https://www.epson.com
https://www.epson.ca
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Scanning Specifications
Ink Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 11
• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012

https://epson.com/recycle-program
https://www.epson.ca/recycle
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• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003 SP2 or later
Windows Server supports only the printer driver and Epson Scan 2; any additional included software is
not supported.

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 12.x
• macOS 11.x
• macOS 10.15.x
• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.) or epson.ca/support (Canada), select your product, and select Downloads.

Parent topic: Technical Specifications

http://www.epson.com/support
http://www.epson.ca/support
http://www.epson.com/support
http://www.epson.ca/support
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Paper Specifications
Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 356 mm])
Executive (7.25 × 10.5 inches [184 × 267 mm])
8.5 × 13 inches (216 × 330 mm)
Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
3.5 × 5 inches (89 × 127 mm)
Half Letter (5.5 × 8.5 inches [140 × 216 mm])
User-defined size paper from 2.12 × 3.39 inches (54 × 86 mm) to 8.5
× 47.24 inches (215.9 × 1200 mm)

Paper types Plain paper

Note: Your product also supports compatible papers distributed by
Epson. See the link at the end of this topic for a list of compatible
Epson papers.

Weight Plain paper: 17 lb (64 g/m2) to 24 lb (90 g/m2)
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Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain paper
Weight 20 lb (75 g/m2) to 27 lb (100 g/m2)

Note: Even when the paper thickness is within range, the paper may not feed or the print quality may
decline depending on the paper types.

Parent topic: Technical Specifications
Related references
Compatible Epson Papers
Compatible Epson Papers

Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets - borders

1 Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
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2 Reduced print quality area/top: 1.61 inches (41 mm) minimum
3 Reduced print quality area/bottom: 1.46 inches (37 mm) minimum

Single sheets - borderless

1 Reduced print quality area/top: 1.73 inches (44 mm) minimum
2 Reduced print quality area/bottom: 1.57 inches (40 mm) minimum

Envelopes

1 Left/right margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.12 inch (3 mm) minimum
3 Reduced print quality area/right: 0.71 inch (18 mm) minimum
4 Reduced print quality area/left: 1.61 inches (41 mm) minimum
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Note: Even when the paper thickness is within range, the paper may not feed or the print quality may
decline depending on the paper types.

Parent topic: Technical Specifications

Scanning Specifications
Scanner type Flatbed, color
Photoelectric device CIS
Effective pixels 10200 × 14040 pixels at 1200 dpi
Document size Maximum: 8.5 × 11.7 inches (216 × 297 mm)

Scanner glass: US letter or A4
Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)
Output resolution 50 to 9600 dpi in 1 dpi increments
Image data Color:

48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color external)
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black and white:
16 bits per pixel internal
1 bit per pixel external

Light source LED

Parent topic: Technical Specifications

Ink Specifications
Color Cyan, Magenta, Yellow, Black
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Ink life Opened package: Use as soon as possible.
Unopened package: Use before the date on the package has
expired.

Temperature Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 5 °F (–15 °C)
Ink thaws and is usable after approximately 2 hours at 77 °F (25 °C)

Parent topic: Technical Specifications
Related concepts
Purchase Epson Ink

Dimension Specifications
Height Stored: 7.0 inches (179 mm)

Printing: 10.0 inches (253 mm)
Width Stored: 14.8 inches (375 mm)

Printing: 14.8 inches (375 mm)
Depth Stored: 13.7 inches (347 mm)

Printing: 22.8 inches (578 mm)
Weight
(without ink and power cord)

8.6 lb (3.9 kg)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 240 V
Input voltage range 90 to 264 V
Rated frequency range 50/60 Hz
Input frequency range 49.5/60.5 Hz
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Rated current 0.4 to 0.2 A
Power consumption Standalone copying: Approximately 12 W (ISO/IEC24712)

Ready mode: Approximately 4.5 W
Sleep mode: Approximately 0.7 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
(without condensation)

Operating: 20 to 80% RH
Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (Device Class for computers); USB 3.0 cables are

not supported

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications

Network Interface Specifications
Wi-Fi

Standard IEEE 802.11 b/g/n; IEEE802.11n available only on the 20 MHz
channel
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Security WEP (64/128 bit)
WPA2-PSK (TKIP/AES), complies with WPA2 with support for
WPA/WPA2 Personal
WPA3-SAE (AES)

Frequency band 2.4 GHz
Communication mode Infrastructure mode

Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b
Maximum radio frequency
power transmitted

20.0 dBm (EIRP)

Security

Security protocol SSL/TLS: HTTPS Server/Client, IPPS
SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
• Manufacturer: Seiko Epson Corporation
• Type: J26H006
This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
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To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.
General Printer Safety Instructions
Wireless Connection Safety Instructions
Parent topic: Notices

General Printer Safety Instructions
• Be sure to follow all warnings and instructions marked on the printer.
• Use only the type of power source indicated on the printer's label.
• Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do

not use the cord with any other equipment.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the printer near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that

regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed.
• If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged

into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

https://epson.com/recycle-program
https://www.epson.ca/recycle
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• Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

• Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

• Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your
product's radio waves from affecting the operation of the pacemaker.

• Leave enough space above the printer to fully raise the document cover.
• Leave enough space in front of the printer for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place the printer near a radiator or heating vent or in direct sunlight.
• Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the

case or insert objects through the slots.
• Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or

the base units of cordless telephones.
• When connecting the printer to a computer or other device with a cable, ensure the correct orientation

of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong
orientation may damage both devices connected by the cable.

• Do not put your hand inside the printer while it is printing.
• Do not touch the flat white cable inside the printer.
• Do not move the print head by hand; this may damage the printer.
• Do not spill liquid on the printer and do not handle the printer with wet hands.
• Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may

cause fire.
• Except as specifically explained in your documentation, do not attempt to service the printer yourself.
• Unplug the printer and refer servicing to qualified service personnel under the following conditions: if

the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the power cord from the electrical outlet if you are not going to use the printer for an extended
period.
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• Before transporting the printer, make sure that the print head is in the home (far right) position.
• When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;

otherwise, ink may leak.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions
Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Parent topic: Important Safety Instructions

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
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For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
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1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

http://www.jamsadr.com


218

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and

http://www.jamsadr.com
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class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON® and Epson Smart Panel® are registered trademarks, EPSON Exceed Your Vision is a
registered logomark, and Epson ConnectTM and Remote PrintTM are trademarks of Seiko Epson
Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.
Apple, Mac, macOS, OS X, and Siri are trademarks of Apple Inc., registered in the U.S. and other
countries.
Google® is a registered trademark and AndroidTM, ChromebookTM, GmailTM, Google AssistantTM, Google
ChromeTM and Google PlayTM are trademarks of Google LLC.
Amazon and Alexa are trademarks of Amazon.com, Inc. or its affiliates.
Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices
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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution
Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Copyright Notice

Copyright Attribution
© 2022 Epson America, Inc.
8/22
CPD-62154
Parent topic: Copyright Notice
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